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1. Welcome to DVD Photo Slideshow Professional

You can use DVD Photo Slideshow to make entertaining photo slideshow playable on TV, create FLV slideshow posting online, generate
MPEG slideshow for iPod, PSP, mobile phone and MP4 player, and build web slideshow for your website.
This section covers:
System requirements: describes the hardware and software required to use the program.
Registration information: describe how to register the program.
Basic elements needed to know: highlights some of the most basic elements that you need to know before you start using DVD Photo
Slideshow.
Workspace of the program: illustrates the work space of the program, including interface, editing buttons and the information display
areas.
How to get help: describe how to get help while you have problem with the program.
Common tasks: highlights some of the most basic tasks that you can accomplish with the program.

1.1 System Requirements
The following is the system requirements of DVD Photo Slideshow Professional:
Intel Pentium III 800M HZ Processor and above
Microsoft Windows 98, ME, 2000, XP, Vista
256 MB of RAM (above is recommended)
200 MB of available hard drive space for program installation
DVD-R/RW or DVD+R/RW drives for burning DVD
Windows-compatible sound card (recommended)
TV connected to DVD player (recommended)
Note
The program may have some compatibility problem with Win98/Me, so it would be better to use WinXP or above.
1.2 Workspace of the Program
DVD Photo Slideshow allows you to create your slideshows with ease. The program provides you a three-step workflow where you can
organize your photos, choose DVD menus and then create in you desired output format.

1. Main Menu contains options that allow you to access all program functions and features.
2. Main Tasks Menu are three steps you need to do to create your slideshow.
3. File and Folder List shows all file folders on your hard drive and network and you can see files in selected folder in right panel.
4. Album Toolbar are used to create or delete an album in the slideshow.
5. Album List displays created albums with their thumbnail.
6. Album Toolbar is for modifying selected album.
7. Slide Toolbar is used to edit selected slide.
8. Slide Panel displays all slides in current album.
9. Disc Size Indicator shows the disc size of your created slideshow.
1.3 Registration Information
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When you are using the trial version of DVD Photo Slideshow, you can only burn maximum 36 photos into each CD/DVD disc.
After you purchase our product, you will be provided a registration name and code to unlock the trial version directly.
Tip for registration:
Run DVD Photo Slideshow, and click the menu Help->Register.

There will be a registration popup dialog. You can input the Name and

Code manually. (The registration name is case sensitive. eg. A is not a . And, please do not add blank at the beginning or the end of the
registration name and code.). You can also copy and paste the Name and Code into the registration popup dialog.
1.4 Getting Help
Need help with DVD Photo Slideshow? There are number of ways to get the help you need.
1. DVD Photo Slideshow Help contains basic information on how to use the program. Several other resources are available on the Internet
for specific help needs:
http://www.dvd-photo-slideshow.com/support.html : Contains basic resolutions to common problems you might encounter while using
our program
http://www.dvd-photo-slideshow.com/faqs.html : Contains the Frequently Asked Questions (FAQ) while using DVD Photo Slideshow
2. Email technical Help - The DVD Photo Slideshow website contains technical support information, ordering information, FAQs and
more. Please visit http://www.dvd-photo-slideshow.com for more information. You may also get our technical support by sending email
to support@anvsoft.com .

2. Getting Started

This section covers:
Basic elements needed to know: highlights some of the most basic elements that you need to know before you start using DVD Photo
Slideshow.
Creating a quick show: shows how to make a slideshow with DVD Photo Slideshow in a very quick way.
2.1 Basic Elements Needed to Know
In order to create a more amazing slideshow, it is quite important to understand the basic elements of a project and relationships among
them. The following are some basic elements needed to know before your start using the program.

Slideshow, Album and Slide
A slideshow is composed of albums as well as a DVD menu (optional).
An album is consisted of photos and music. You can create more than one album in a slideshow.
A slide includes the photo, its decorations and captions.

Album Theme
An album theme can determine the visual styles of the album. You can add titles and credits to the album with different effects when you
apply album theme.

Setting Options
Before creating your slideshow, you can specify the working folder, default background music and transition effects. Select View:
Options to view Options window. Click General tab to specify the location of temporary folder of the project created by the program.
Album playback order in DVD mode can also be set here. TV system must be specified here, if you want to watch your slideshow on TV.
Click Album Default Setting tab to set default background music and transition effects for the album. You can create a quick show with
this method.

Starting a Project
When you run the program, a new project will be opened automatically. A new project always applies the default settings of DVD Photo
Slideshow. You can view and modify these settings in Options window by selecting View: Options.
Select File: Open to open an existing project on your computer.
Remember to always save your modification by choosing File: Save.

Copying a Project
You can copy all photos and project file to another computer with the same folder name. The project only saves the photo directory not
the photo itself. You also need to install DVD Photo Slideshow on the computer.
Another way is to create the image file from your photo album and copy the image file to your client's computer. On the computer with
DVD burner, you can use Nero Burning software to burn the image file to DVD disc.
2.2 Creating a Quick Show
Try the following to create a very quick show:
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1. Setting Default Setting
After you run the DVD Photo Slideshow, choose the View> Options. Then set default setting in the Options Window , including transition
effects and background music. You can also set the parameters of your output file, including its DVD menu, format, playback order, etc.
2. Adding Photos
Select your desired file folder in the File Folder List and its content will be displayed in the Slide List. Drag and drop your selected photos
to the Slide Panel. You can arrange your slides after they are added by clicking and dragging them in the Slide Panel.
3. Exporting Slideshows
You can choose your desired output format and then export your creative slideshow on disc, website or mobile devices. Click Create Now
and your slideshow will be exported with only few minutes.
After these three easy steps, you can enjoy your creative slideshow on TV, PC or mobile devices. But if you want make your slideshow
more animated and personalized, please follow our step-by-step guidance.

3. Starting a Project

When you run DVD Photo Slideshow, it automatically opens a new project and lets you start creating a slideshow. A new project always
uses DVD Photo Slideshow's default project settings. To see and modify these settings based on your Options, select View: Options.

Saving Project
1. Select File > Save/Save As.
2. Name your show.
3. Click Save and the project will be saved with *pdm extension.

Opening Existing Project
To open an existing project, select File > Open.

Exploring Temporary Folder of the Project
When you burn your slideshow to disc, a copy of your show will be saved automatically in the Temporary Folder, which is prepared for your
future use. If you want to see this folder, just click File >Explore Temporary Folder or View > Options get more information.

Adding Albums to the Project
The Album Toolbar provides two options: creating a photo album and deleting an existing one.

: Create a new album.

: Delete the selected photo album
Note
Actually, each album can be regarded as an individual slideshow, and you can apply different album theme, background music to each of
them. If you want to burn more than one album on a disc, you can create multiple albums in one project. Click New repeatedly to create
multiple albums easily.

4. Organizing Albums and Music

After creating and saving your project, you can begin to add photos to each album, organize them, edit them as well we add background
music to the album.
Adding photos: Highlights how to add photos from file folder on your hard drive.
Sorting photos: Describe how to sort added photos
Editing photos: Describe how to edit photos by choosing transition effect, customizing pan&zoom effect and adding text, art clips to
selected slide.

Adding videos: Shows how to create video album and add clips
Adding background music: Shows how to add music from your hard drive and audio CD.
Recording audios: Describe how to record audios and then add to the slideshow.
Trimming music: Describe how to trim added background music to make it match with the slideshow.
4.1 Creating Video Album
With DVD Photo Slideshow Professional, you can create an individual album to add video clips.
-Click the New button in Album Toolbar and check Video Album option to create videos album or just simply right-click on Album List panel
to choose to create New Video Album.
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-Click the Add or Add All button to select video clips from your hard drive.

4.2 Organizing Photo Albums
This section covers information about how to add photos from your local drive, sort added photos and edit photos.
Adding photos to the album
Sorting added photos
Editing photos

4.2.1 Adding Photos to the Album

You can add photos to the slideshow easily with the following methods:

1. Click Add button on the slide toolbar to select photos from file browse pane. Click Open to add selected photos to the album. Press Ctrl
or Shift key to select multiple photos at one time.
2. Unfold the folder which images are located at in the left panel and then double-click your desired photo in the right panel and it will be
added to the album. Add photos from right panel will not change original photo order.
3. Right-click on the right panel and choose Select All in the pop-up menu. Click Add All button in slide toolbar, and then all the photos
in the current folder can be added to the album.
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4. Drag and drop photos from the right panel onto the slide panel.
5. Right-click on the slideshow list panel and choose Batch Collect in the pop-up menu, and then a pop-up window will appear. Check the
folder containing pictures and all photos in the folder will be added to the slideshow with the same name of folders and its subfolders
respectively.
Note
The program does not save photo files and it only saves the photo file location. If your photos are stored on a CD/DVD disc or other
removable drives, we suggest you copy your photos on your CD disc to your computer with the same folder name and create a slideshow
by adding photos from your hard drive.

4.2.2 Deleting Added Photos

You can delete added photos by following two methods:
1. Click

button on the slide toolbar to remove selected photo from the album. Press Ctrl or Shift to select more than one photo at

one time.

2. Right-click selected slide and choose Remove to delete the slide. Choose Remove All if you need to delete all photos in current album.
Note

This operation just removes photo from your album not your hard drive.

4.2.3 Sorting Photos

You can sort photos in both file list and slide panel.

File list sorting
There are a number of different choices for sorting your files in the File List. To rearrange your files using a different sorting method,
simply right-click in the File List and choose Arrange Icons by, then select the desired sorting option.

Sorting Added Photos
After adding photos to the album, you can simply sort it by following ways:
1. Drag and drop within slide panel.
2. Sort by different sorting methods, such as Name, Date and Size. Simply choose right-click on Slide Panel and choose Details in pop-up
menu and then you can all photos are displayed with their detailed information. Click your desired method on the panel at the top to sort
photos in this method.

4.2.4 Editing Photos

You can edit added photos using several methods. Double-click the photo and you can see pop-up Photo Configuration window. This
section covers how to edit photos in Photo Configuration window.
Selecting transition effects: more than 260 transitions are provided for your selection. Duration of photo and transition can also be
changed here
Customizing pan and zoom: not only choose pan and zoom effect and set pan and zoom duration and rotation.
Adding text and art clips: animated text can be added to slide and various art clips can be added as well.
Adding subtitles: add subtitles to make your slideshow more professional.
Processing photos: adjust the brightness and contrast of photos.
Adding sound annotation to the slide: add your own music or narration to selected slide.

4.2.4.1 Selecting Transition Effects

With DVD Photo Slideshow, you can customize transition effect of single slide, apply no transition to the album and randomize selected
transition to selected slides or the whole album as well.

Customize Transition of a Slide
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1. Double-click the slide and you can see Photo Configuration window.
2. Click Transition tab and then check Custom option.
3. Choose desired effect in drop-down list and click Preview to preview the final effect of selected effect.
4. Change Photo and Transition duration. This setting is only applied to the current slide not the whole album.
5. Click Next button to change settings of the next slide.
6. Click Done to finish your settings.

Note
You can apply desired transition to the slide simply by right-clicking on the transition icon and choose Apply to selected photo or
dragging and dropping the icon onto the slide.

Apply No Transition to the Album
Simply click N/A button in Transition and Music tab window.

Apply Same Transition Effects to the Album
Right-click on desired transition icon and choose Apply to all photos of current album.

Randomize Selected Transition to Selected Slides or the Whole Album
1. Click Subset button in Transition and Music tab and you will see a pop-up window.
2. Click Add to add desired transition from the left Unselected Transition Effect panel. Your added effects will be shown in the right
panel.
3. Click Remove to delete unsatisfied one.
4. Click Add All or Remove All to add or remove all the built-in transition effects.
5. Check the Default setting for next new album option to apply the same transition effects randomly to the next album in the
slideshow.
6. Click Randomize to finish setting.

Note
If you need to change photo or transition duration overall, you can click Transition&Music tab and then you will find an Album Settings
panel and you can input your desired duration time here.

4.2.4.2 Customizing Pan and Zoom Effects

By using DVD Photo Slideshow, you can pan, zoom and rotate content to create a variety of dramatic effects. Moreover, you can copy a
customized effect to other slides easily. The following are some useful parameters here:
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Pan: changes the position of the content in the slide.
Zoom: changes the size of the content.
Rotate: changes the angle of the content.
Copy Position: copies the current customized effect
Paste Position: pastes the copied effect to current slide.

1. Double-click the slide and you can see Photo Configuration window.
2. Click Pan and Zoom tab and then check Custom option.
3. Choose desired effect in drop-down list and click Play to preview the final effect of selected effect.
4. Change pan, zoom and rotation settings. If you would like to copy this effect to other slides, click Copy Position button.
5. Click Next button or click the slide in the right panel of the window to change settings of the next slide. If you just want to apply copied
settings to the slide, just click Paste Position.
6. Click Done to finish your settings.

Note
If you do not need pan and zoom effect, just uncheck Pan and Zoom option in Album Settings panel of Transition and Music tab.

4.2.4.3 Adding Text and Art Clips

This feature can help you add customized text and art clips to selected slide or all slides.

Add Text to a Slide
1. Double-click the slide you want to customize and you can see Photo Configuration window. You can also access this feature by clicking
Text tab in Slide Toolbar.
2. Click Text tab and then double-click on the slide to enter desired text.
3. Drag and drop the text to change its position.
4. Change text font, size and color in the bottom panel after you click the text.
5. Click Done to apply the settings.

Add Macro Text to a Slide
1. Double-click any slide in the album and then come to Photo Configuration window.
2. Click Add Macro Text button in bottom panel and then choose the specified macro text from the drop-down list.

Add Art Clips to a Slide
1. Double-click any slide in the album and then come to Photo Configuration window.
2. Click Artclip tab and then simply select art clips from the built-in art clips by double-clicking the desired one in bottom panel.
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3. Drag and drop art clip to change its position.
4. Click More to select art clip from your hard drive.

Add Same Text/ Art Clips to the Album
1. Double-click any slide in the album and then come to Photo Configuration window.
2. Click Text/ Artclip tab and then double-click on the slide to input desired text.
3. After you finish inputting/selection, click the input text/selected art clip and then click Apply Select to All button in bottom panel. Your
selected text will be applied to each slide in current album.
4. If you would like to edit text again, you can just edit it on one of the slides. The changes will be applied to all slides.
Note
If you want to play your burned slideshow on wide screen TV, you’d better choose Organize > TV Aspect 16:9 before you edit photos.

4.2.4.4 Adding Subtitles

This feature can help you add subtitles to slides.

Add Subtitles to a Slide
1. Double-click the slide you want to customize and you can see Photo Configuration window.
2. Click Subtitle tab and then enter desired subtitles into text pane.
Note: With current version, subtitles cannot be previews before you burn the slideshow.

Edit Subtitles Font and Size
. Double-click album thumbnail in Album List.
2. Change subtitles font and size in the pop-up window.
This feature is only available when you play slideshow on TV.

4.2.4.5 Processing Slides

This feature is to help you adjust the image effects, such as brightness, contrast.
1. Double-click the slide you want to customize and you can see Photo Configuration window.
2. Click Process tab and then drag the slider to adjust contrast, brightness, etc.
3. Check Auto Exposure option to make photos look much brighter.

4.2.4.6 Adding Sound Annotation to the Slide

You can also add your own narration to individual slide. Click the duration time marked on the slide and you will see a pop-up window.
1. Check Enable Sound Annotation option.
2. Click Browse to select readied audio file in WAV, WMA and MP3 format from your hard drive.
3. Click Record to input your sound resource at once.
4. Click Trim to trim added audio.
4. Check Same as Sound Annotation option to make the slide duration match with the duration of added sound.
4.2 Organizing Background Music of the Album
You can add multiple music files as the background music of the album from local drive, CD and recording devices. After you add
background music, you can trim them as you like. The current version of the program supports music in MP3, WMA and WAV format.
4.2.1 Adding Music from Local Drive
After you come to Transition and Music tab, click Add button to select music from your hard disk.
1. Click Add button and select desired one from file browse pane.
2. Click Open to add selected files to current album. All added music will be displayed in Background Music panel.
3. Press Ctrl or Shift key to select multiple music files at one time.
4. Click

to adjust the order of added music.

Note
The current version of the program can only support music in wma, wav and mp3 format, so if you try to add music in these formats, but
failed, then music you added may be licensed. You can use licensed music by recording it or converting it to plain format with other audio
converting tool.
4.3 Organize Album Background Music
You can add multiple music files as the background music of the album from local drive, CD and recording devices. After you add
background music, you can trim them as you like. The current version of the program supports music in MP3, WMA and WAV format.
Adding music from local drive

DVD Photo Slideshow User Manual

11

Importing audios from CD
Recording audios
Trimming selected music

4.3.1 Adding Music from Local Drive

After you come to Transition and Music tab, click Add button to select music from your hard disk.
1. Click Add button and select desired one from file browse pane.
2. Click Open to add selected files to current album. All added music will be displayed in Background Music panel.
3. Press Ctrl or Shift key to select multiple music files at one time.

4. Click

to adjust the order of added music

Note
The current version of the program can only support music in wma, wav and mp3 format, so if you try to add music in these formats, but
failed, then music you added may be licensed. You can use licensed music by recording it or converting it to plain format with other audio
converting tool.

4.3.2 Importing Audios from CD

You can choose to extract audio tracks from your CD. These extracted audio file will be saved in .wav format.
1. Insert you audio CD.
2. Click Ripper button in Transition and Music tab.
3. Check the option box in the front of your desired audios.
4. Click Extract to begin to extract selected audios from CD.
5. Click Close to return to the previous window
6. After finishing extraction, all imported audios will be saved in WAV format and added to the album automatically.

4.3.3 Adding Recorded Audios to the Album

You can choose to record audio or your narration with other audio recording devices in our program.
1. Click Record button in Transition and Music tab.
3. Choose your input and record devices. Drag the slider to adjust the audio playback volume and recording volume.
4. Click Start Recording to begin to record your narration or the playing audio.
5. Click Stop Recording to finish the recording. Your recorded audio will be added to the album automatically.
6. The recorded audio can also be trimmed as the audio added from local drive.
If you would like to add your own narration to the album, please refer to adding sound annotation to the album.

4.3.4 Trimming Selected Background Music

With DVD Photo Slideshow, you can easily crop audio for use in your show. Double-click the audio in Background Music panel and you can
see a pop-up window. You can also click selected audio and then click Trim button to view this window.
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1. Click the Play button to play the selected music. Click the Return button, you can have the music return to the start point you set or
the very beginning.
2. Drag the slider to your desired point and click Start Point button or End Point button to make the music start from or end with this
point.
3. Click Cancel to cancel your changes.
4. Click OK to save your changes.
Note

You can trim the trimmed music again by repeating the operations mentioned above.
4.4 Applying Album Theme
Album Theme decides the overall visual appearance of your album. In Album Theme tab, you can choose a theme template for current
album and then add and edit titles and credits of the album.

1. Select an album theme from the provided templates in the right panel.
2. Enter titles and credits in the pane below and set their font size, color and effect in this pane, too.
3. Click Preview to view the effects of titles and credits page.
Note
If you encounter some problems while selecting album theme, please make sure you have installed the latest flash player installed.
4.5 Previewing the Album
Click Preview tab of Organize Photos window to preview your modified album.
1. Click
2. Click

to preview from the very beginning of the album.
to preview from the selected slide. You can firstly click the slide which you would like the preview to start from in Album

Photo tab and then return to Album Preview.
3. Click

to stop the preview.

Note

This preview tab is only for the preview of the current album not for the whole slideshow. You can preview the whole slideshow in Choose
Menus window.

5. Editing DVD Menu

Use DVD menu
The menu options control the theme and layout, as well as additional customizations.
Choosing menu template
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Adding background music to menu
Changing menu background
Setting album playback order

Use No Menu
If would like to use no menu, please uncheck Use DVD Menu option in Menu Navigator tab of Choose Menus window.
5.1 Choosing Menu Template
For speed and ease in designing your slideshow album, simply select from the list of templates. All the backgrounds, effects, and audio
that come with the template are automatically applied to your slideshow album. You can click the selected template to apply it to your
slideshow album.
5.2 Adding Background Music to Menu
Choose your favorite music from local drive or audio CD to add as the background music of DVD menu. Audios in MP3, WAV or WMA format
are supported. For best results, choose a short clip of music that can easily repeat.
1. Click Background Music tab.
2. Click Add or Import from AudioCD button to select a music file from the local drive or your audio CD.
3. Click Delete to remove the selected music.
4. It is recommended to check Set Fixed Duration option, since the longer your menu background music is, the longer you will need to
encode the slideshow.
5.3 Changing Menu Background Image
The background image of all menu templates can be changed by your own images.
1. Click Background Images tab.
2. Click Add button to select you desired image on your computer.
3. Click Delete to remove the selected image.
4. Check Show Gray Scaled Image option to make the images look black-and-white.

Note
If you add more than one image as the background, they will be displayed one by one.
5.4 Setting Album Playback Order
Here, you can set the playback order of the whole slideshow.
1. Click Menu Navigator tab.
2. Choose desired order from the drop-down list.

Note
If you do not like to use DVD menu, please uncheck Use DVD Menu option here.

6.

Previewing the Slideshow

Here, you can preview the whole slideshow with DVD menu.
1. Click Preview tab.
2. Click Menu or Play button on the Control Panel of preview window to start previewing.
3. After you see menu page, click corresponding number button on control panel to play the album.

7. Disc Size Indicator

There is no limitation on the number of files you add to a slide show. There are limitations, though, depending on what output format you
choose. The program can calculate the disc space used when photos or background music are added into slideshows. Normally, One 4.7G
DVD-R disc can holds more than 1500 photos with background music. One CD-R disc can hold more than 500 photos depending on the slide
interval time.
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Note
The calculation made by the program is not quite exact, so if you want to know the exact size, you can create image file with the program
and then the image file size is the exact size of your slideshow.

8. Exporting the Slideshow

With DVD Photo Slideshow, you can output your show in a variety of formats. Each format can help you provide the best experience for
your audience. Some formats play only on TVs; some can be played on your PC or upload to internet. When choosing how to output your
show, you'll need to determine which factors are most important and select the format which best fits your needs. The following is the
format for your selection in the program.
Slideshows for TV playback: burn slideshow on CD or DVD disc and play on TV.
Slideshows for uploading to web: output slideshow in MPEG or FLV format and upload to YouTube or MySpace.
Slideshows for mobile devices: build slideshow playable on iPod, PSP, mobile phone or MP4 player.
Web slideshow: generate slideshow in HTML format.
Creating image file of the slideshow: create image file of the slideshow for future use
8.1 Burning Slideshow on Discs
Burning on DVD disc
If you have DVD burner and DVD player, you can burn your slideshow on DVD disc and then watch it on TV.
Standard resolution for DVD output is 720 x 480 (720 x 576 for PAL). This is much lower resolution in comparison to PC playback
resolution.
Burning on CD disc
If you just have a CD burner, you can burn the slideshow on CD disc. You can choose SVCD or VCD 2.0 as the output. With VCD 2.0, all
transition effects and background music are not available.
Standard resolution for VCD 2.0 output is 352x240 (352x288 for PAL) and for SVCD output is 480x480 (480x576 for PAL).
Creating image file
If you need to burn the slideshow on another computer, you may create image file of the slideshow.

Settings for DVD/CD Slideshow
Before you burn the slideshow on disc, you need to set following parameters firstly.
DVD/CD File System
Click DVD/CD File System tab in Burn Disc window and you can set following parameters here.
1. Add label, publisher and copyright information to your disc: input these information in corresponding text pane.
2. Save original files of images you used: check the Save original image files on disc option
3. Burn additional files on the disc: check the Save some additional files on the disc option and then click Add Extra Files
button to save other additional files on the burned disc. (Note: these additional files can only be viewed on computer)
TV System
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Click TV System tab in Burn Disc window and you can set following parameters here.
1. Select the TV system: select TV system used in your country by checking PAL or NTSC.
2. Setting TV cropping Proportion: drag the slider to adjust it. (The default value is 10%)
3. Select your TV Aspect Ratio Correction: choose from 16:9 (for wide screen TV), 4:3 and No Correction.
4. Apply anti-flickering filter: check it if you need.
DVD/CD Recorder Options
Click DVD/CD Recorder Options tab in Burn Disc window and you can set following parameters here.
1. Burning Speed: this option is only available to users whose drive supports multiple speeds.
2. Simulate burning: check it to make the disc not actually be burned and test the burning process to see if it functions
correctly.
3. Input Copies of burned disc: specify the number of copies to make of the disc.
4. Select burning engine: you can select burning engine between Internal Burning Engine and Anvsoft Burning Engine.
If you encounter burning problem, you may change the burning engine and/or burning engine driver mode to have a try.

8.1.1 Burning Slideshow on DVD Disc

You can burn slideshow on DVD as follows:
1. Click Burn Disc tab.
2. Choose DVD as the Output Format.
3. Select your burner from drop-down list of CD/DVD Recorder.
4. Customize your DVD using the various category options in the Create DVD Disc window. (Refer to Settings for CD/DVD Slideshow)
5. Click Burn Now to begin encoding your slideshow.

8.1.2 Burning Slideshow on CD Disc

You can burn slideshow on CD disc as follows:
1. Click Burn Disc tab.
2. Choose VCD 2.0 or SVCD as the Output Format.
3. Select your burner from drop-down list of CD/DVD Recorder.
4. Customize your VCD/SVCD using the various category options in the Create CD Disc window. (Refer to Settings for CD/DVD Slideshow)
5. Click Burn Now to begin encoding your slideshow.

8.1.3 Creating Image File for Future Use

If you need to burn your slideshow on another computer or you encounter some problems with your CD/DVD burner, you may create image
file with the program and then use other burning software to burn. You can create image files by following steps:
--Choose DVD/SVCD as the output format in Burn Disc window.
--Choose Image Recorder in the recorder options or check Create image files option.
--Click Burn Now button and select a folder to save your image file.
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--Click Open and then your image file will be saved in .iso/.cue format and after burning, please use other burning software to burn this
image file on disc.
8.2 Outputting Slideshow for Uploading to Web
If you would like share your slideshow on internet, you may choose FLV or MPEG as the output format.
Options of Slideshow for Uploading to Web
With DVD Photo Slideshow, you can encode your created slideshow to formats which are supportable by web browser. You can not only
enjoy your show on your PC, but upload it to website, such as YouTube and MySpace, and share your amazing works with friends and
families in the most convenient way. By default, the program has some technical parameters be set, however, you can also set these
parameters to fit your needs.
Video Codec: Generally, the default setting for each format has been set by the program. In our experience, the set codec works very well
in terms of both quality and speed.
Video Size: This specifies the output video resolution. It is not advisable that you set this to a high resolution, as the resulting video file
will be huge, and it can take too long for your audience to stream it.
Bitrate: The bitrate of the video specifies the amount of information stored in the video. The higher the bitrate is, the clearer the video
is . This setting will usually depend on your chosen resolution, and it's best to leave it as Auto. Should you decide to make your video
clearer, you can try to increase this parameter.
Framerate: The framerate determines how fast the video frames refreshes. For video with lots of fast moving action, you will need a higher
framerate to combat jerkiness. The default value will usually suffice for most cases.
Audio Bitrate: The audio bitrate determines the amount of information stored in the audio. A higher bitrate will result in clearer audio, but
comes at the expense of file size.
Audio Sampling: The audio sampling rate determines the "resolution" of the audio. The higher the sampling rate, the clearer the audio.
However, this comes at a expense of a bigger file size.
Audio Channels: You can choose to use mono or stereo. This is set to stereo by default.
Once you are done, you can click on Create Now to start the exporting process. your output file will be saved automatically as a folder in
your directed path.

Note
If you would like upload slideshow to your own website, you may choose to make web slideshow.

8.2.1 Creating Web Album

With our program, you can create web album of your slideshow. The output is an HTML page and you can upload this file to your website
directly.
1. Click Burn Disc tab.
2. Choose Web Album as the Output Format.
3. Choose output folder of the slideshow by clicking Browse.
4. Choose a desired album template.
5. Click Create Now to export your slideshow in .flv format.
The generated album is a set of pages, images, resized photos and flash movies with XML configuration files in case of the flash galleries.
All these files are located in the Output Folder that you can open it by choosing File>Open Output Directory.
You should publish all files and subfolders without renaming them or changing the folder structure. After you publish created album, a
folder with name of the template you choose will be created automatically and all files of published album are included. Please just copy
all subfolders in this folder to your site.
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8.2.2 Uploading Slideshow to YouTube

With our program, you can create slideshow in .flv format, which is supported by YouTube.
1. Click Burn Disc tab.
2. Choose YouTube Uploadable Movie as the Output Format.
3. Choose output folder of the slideshow by clicking Browse.

4. Set the technical parameters based on your demand. (Refer to Options of Slideshow for Uploading to Web)
5. Click Create Now to export your slideshow in .flv format.
6. After encoding finishes, the output folder of YouTube movie will be open automatically. You can use your video player on your computer
to watch the slideshow. After that, you can log in your YouTube account and choose to upload the video.

8.2.3 Uploading Slideshow to MySpace

With our program, you can create slideshow in .mp4 format, which is supported by MySpace.
1. Click Burn Disc tab.
2. Choose MySpace Uploadable Movie as the Output Format.
3. Choose output folder of the slideshow by clicking Browse.
4. Set the technical parameters based on your demand. (Refer to Options of Slideshow for Uploading to Web)
5. Click Create Now to export your slideshow in .mp4 format.
6. After encoding finishes, the output folder of MySpace movie will be open automatically. You can use your video player on your computer
to watch the slideshow. After that, you can log in your MySpace account and choose to upload the video.

8.2.4 E-mailing the Slideshow

You can choose to output your slideshow in MPEG format and send it as an e-mail to your friends.
1. Click Burn Disc tab.
2. Choose MPEG Movie as the Output Format.
3. Choose output profile from MPEG-1, MPEG-2 and MPEG-4. Among these three formats, MPEG-4 is smaller in file size.
3. Choose output folder of the slideshow by clicking Browse.
4. Set the technical parameters based on your demand. (Refer to Options of Slideshow for Uploading to Web)
5. Click Create Now to export your slideshow in .mpg or .mp4 format.
8.3 Outputting Slideshow for Mobile Devices
You can export your slideshow in formats which are supported by mobile devices, such as iPod, mobile phones, PSP and MP4 player.
Note
If you would like upload slideshow to your own website, you may choose to make web slideshow.

8．3．1 Playing Slideshow on iPod

With our program, you can create slideshow playable on Apple iPod.
1. Click Burn Disc tab.
2. Choose iPod MPEG-4 Movie as the Output Format.
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3. Choose output profile from iPod(30G/60G) MPEG-4 Movie and iPod Video(640 by 480).
3. Choose output folder of the slideshow by clicking Browse.
4. Set the technical parameters based on your demand. (Refer to Options of Slideshow for Uploading to Web)
6. Click Create Now to export your slideshow in selected format.
After encoding finishes, the output folder of iPod movie will be open automatically. You can import created slideshow to your iPod directly.

8．3．2 Playing Slideshow on PSP

With our program, you can create slideshow playable on Sony PSP.
1. Click Burn Disc tab.
2. Choose PSP MPEG-4 Movie as the Output Format.
3. Choose output folder of the slideshow by clicking Browse.

4. Set the technical parameters based on your demand. (Refer to Options of Slideshow for Uploading to Web)
6. Click Create Now to export your slideshow in .mp4 format.
After encoding finishes, the output folder of PSP movie will be open automatically. You can import created slideshow to your PSP directly.

8．3．3 Playing Slideshow on Mobile Phones

With our program, you can create MPEG-4 slideshow playable on 3GP mobile phones.
1. Click Burn Disc tab.
2. Choose Mobile Phone Playable Movie as the Output Format.
3. Choose output profile from MPEG-4 Movie, 3GP and 3GP2.
3. Choose output folder of the slideshow by clicking Browse.

4. Set the technical parameters based on your demand. (Refer to Options of Slideshow for Uploading to Web)
6. Click Create Now to export your slideshow in selected format.
After encoding finishes, the output folder of mobile phones will be open automatically. You can import created slideshow to your PSP
directly.

Note
Make sure you have selected the correct video size for your mobile phone.

8.3.4 Playing Slideshow on MP4 Players

With our program, you can create slideshow playable on various of MP4 players, such as Archos, Creative Zen Vision and iRiver PMP.
1. Click Burn Disc tab.
2. Choose Archos Movie/Misc Movie as the Output Format.
3. Choose output profile according to the MP4 player you use.
3. Choose output folder of the slideshow by clicking Browse.
4. Set the technical parameters based on your demand. (Refer to Options of Slideshow for Uploading to Web)
6. Click Create Now to export your slideshow in selected format.
After encoding finishes, the output folder of create slideshow will be open automatically. You can transfer slideshow to your MP4 player
directly.
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8.4 Creating Web Slideshow
If you have your own website, you can choose to create web slideshow with the program. The output of web slideshow is in HTML format
and you can upload it to your site easily.
1. Click Burn Disc tab.
2. Choose Web Album as the Output Format.
3. Choose a desired web style from bottom panel by clicking its name.
3. Choose output folder of the slideshow by clicking Browse.
4. Click Create Now to export your slideshow in html format.
After encoding finishes, the output folder of web album will be open automatically. You can copy all files in the output folder to your
website.

9. Appendices

9.1 Supported File Formats
Image Formats
JPEG
TIFF
BMP.
PNG
Audio Formats
MP3
WAV
WMA
Output Formats
DVD
SVCD
VCD 2.0
FLV MPEG-1
MPEG-2
MPEG-4
AVI
HTML
9.2 Drag-and-drop Used in the Program
You can finish drag-and-drop with the following three steps:
Step 1: Select the resource object you want to drag. Press the left key of mouse and hold on.
Step 2: Move the object to the target position. Once you begin to move, you will see a shadow of the selected object move with the moving
of the mouse.
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Step 3: when you move the selected object to the desired position, please release the left key and it will be moved to your desired
position.
For example, if you want to apply a transition effect (Zigzag Wipe-Vertical) to the selected slide (the second slide in the list), you can do
that as follows:
1. Select your desired transition effect in the transition icon list.
Select the transition effect Zigzag Wipe-Vertical and then press the left key of the mouse and hold on.

2. Move the selected transition to the transition effect icon of the second slide.

3. Release the left key of the mouse and the previous transition, Whirlpool, will be changed into the Zigzag Wipe-Vertical.
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If you want to drag more than one target at the same time, please press the Ctrl ( for inconsecutive targets) or Shift ( for consecutive
targets) while dragging and dropping.
In DVD Photo Slideshow, you can create your slideshow more quickly and conveniently with dragging and dropping. Here, you can see
where you may use drag-and-drop in the program.
--Adding and Rearranging Photos
1. Drag and drop your desired photos from the slide list to the slide panel and add them to your slideshow. (Learn More)
2. Drag and drop the thumbnail of the slide in the slide panel to rearrange the slide order in the album.
3. Drag and drop your desired slide in another album to the target album to move the selected slide to your target album.
--Creating and Rearranging Album
1. Press Ctrl and then drag the thumbnail of a selected album to your desired target album, then the selected album will be copied to the
target album.
2. Drag and drop the thumbnail of the album in the slideshow list to rearrange the order of the album.

--Setting Album Thumbnail
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Drag and drop the selected slide to the slideshow thumbnail in the slideshow list, the selected slide will be set as the thumbnail of the
target album.
--Adding Background Music
1. Drag and drop your desired music from the file list to the background music list to add the selected music to the album as the
background music.
2. Drag and drop your selected background music from the added background music list onto the selected slide thumbnail or transition
icon to make the music start from the slide or the transition effect.
--Adding Artclips
Drag and drop your desired artclips from the provided artclips to the slide to add the artclips to the slide.
--Placing the Onscreen Text of DVD Menu
Drag and drop the onscreen texts on the DVD menu to your desired position quickly.
9.3 Right-click Used in the Program
Press the right key of the mouse, and generally, and there will be a pop-up menu. you can modify your slideshow very conveniently. In
DVD Photo Slideshow, You can have right-click in following occasions.
-- Adding and Selecting Photos
Have a click on the selected photo in the slide list to choose add it to the current album or select all the photos in the file folder.
--Creating and Deleting Album
Have a right-click on the slideshow list panel, you can choose to create new album, delete selected album, view the properties of the
slideshow or have a batch collect.
--Modifying the Slide in the Album
Have a right-click on the selected slide and you can choose to remove it , remove all the slides in the current album, set the selected slide
as the thumbnail, add blank image or rearrange the current slide order.
--Applying Transition Effects
1. Have a right click on the selected transition effect icon, you can choose to apply it to the selected slide or to all the slides in the current
album.
2. Have a right-click on slide panel to select several transition effects to apply to the album randomly.
--Adding Artclips and Onscreen Text
Have a right-click on the selected added artclips or onscreen texts, you can choose to copy, delete or apply to all the photos in the current
album.
9.4 TV System Used in Countries
List of Countries Using PAL
Afghanistan

Guinea

Poland

Albania

Holland

Portugal

Algeria

Hong Kong

Qutar

Angola

Iceland

Romania

Argentina **

India

Singapore

Australia

Indonesia

Somalia

Austria

Ireland

South Africa

Azores

Israel

S.W. Africa

Baharain

Italy

Spain

Bangladesh

Jordan

Sri Lanka

Belgium

Kenya

Sudan

Botswana

Kuwait

Swaziland

Brazil *

Laos

Sweden
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Brunei

Liberia

Switzerland

Cameroon

Madeire

Tanzania

Canary Islands

Malaysia

Thailand

Cyprus

Malta

Turkey

Denmark

Mozambique

Uganda

Dubai

Nepal

United Arab Emirates

England

New Guinea

United Kingdom

Ethiopia

New Zealand

Uruguay **

Faeroe Islands

Nigeria

West Germany

Finland

North Korea

Yemen

Ghana

Norway

Yugoslavia

Gibraltar

Oman

Zambia

Greece

Pakistan

Zimbabwe

Greenland

Paraguay **

List of Countries Using NTSC
Antigua

El Salvador

Philippines

Bahamas

Ecuador

Puerto Rico

Barbados

Guam

Saipan

Barbuda

Guatemala

Samoa

Belize

Haiti

South Korea

Bermuda

Honduras

Saint Kitts

Bolivia

Jamaica

Saint Lucia

Burma

Japan

Saint Vincent

Cambodia

Mexico

Surinam

Canada

Midway Islands

Taiwan

Cayman Islands

Netherland Antilles

Tobago

Chile

Nicaragua

Trinidad

Colombia

North Mariana Island

United States

Costa Rica

Panama

Venezuela

Cuba

Peru

Virgin Islands

